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Outline of Main Window 
Start LX Navi program, the following main window will be displayed. 

Menu bar Toolbar Status display 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
These enables you to switch between 
the Recording mode(REC) and the 
view mode(VIEW), check the name of 
a recording file, select the name of a 
recording file, select the files to be 
reproduced, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Menu bar 

New: Select the device on which 
data is to be recorded, and 
specify the file name. 

Open: Select data to be reproduced. 
Copy: Copy data. 
Format: Format a media. 
Exit: Quit the application. 

System: Set operations, recording conditions,
and reproduction conditions. 

Trigger: Set trigger actions. 
Params: Property: Save or load settings. 

Toolbar： Display or hide the toolbar. 
Status Bar： Display or hide the status bar.
Bar： Display or hide bar meters. 
Digit： Display or hide digital values. 
Hdr： Display or hide header information.

Area for displaying waveforms
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Toolbar 

Status display 

File → New 

File → Open 

File → Copy 

Setup → System

Setup → Trigger 

Setup → Params Property 

Read TEDS information

Auto offset, 
Calibration 

Skip settings

Skip to previous 

Skip to later 

Stop 

Rec standby

Start

Pause 

Event mark 

Eject

Stop the fan 

Listen to data

View → Bar 

View → Digit 

Execute calibration

View → Hdr 

Zero balance

Remaining fan-stop time 

Displays the mode: RECORD for 
recording or VIEW for reproduction.

Current date and time 
In View mode: date and time of recording Number of event marks 

Operating status 
STOP: Idle status 
RECSTANDBY: Recording-standby status 
REC: Now recording 
PLAY: Now reproducing 
PAUSE: Reproduction is paused 

Elapsed time 



Overview of Steps in Recording and Reproduction 

3-4 

Overview of Steps in Recording and Reproduction 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mode becomes the view mode. 

Start LX Navi 

Recording 
File, New 

Reproducing 
File, Open 

Specify the recording device and file name. 

Mode becomes the recording mode. 

Operations to control recording 

After finishing recording to memory, store on media or PC. 

Select the file to be reproduced. 

When the memory 
recording is selected 

Operations to control reproduction 
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System Settings 
To specify settings fro the LX operations, from the Setup menu choose System. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Sample 
Select the sampling frequency.  Select the sampling frequency series including the sampling frequency to be 

selected at the upper row, then select the sampling frequency within the list shown at the lower row.  They 

are to be limited based on the selected recording media and the tachometer pulse input channels.  See 

“1-13 Sampling Frequency and Number of Channels”.  

 

 

 

 

 

 

 

 

 

 

 

 

LX-10/10L 

You can select the sampling frequency series of 96k-1.5k only at the upper row for the sampling frequency of 96 kHz, 48 

kHz, 24 kHz, 12 kHz, 6 kHz, 3 kHz, or 1.5 kHz at the LX-10/10L.  

LX-20/20L 

You can select the sampling frequency from the followings;  

96k-1.5k for 96 kHz, 48 kHz, 24 kHz, 12 kHz, 6 kHz, 3 kHz, or 1.5 kHz 

100k-1k for 100 kHz, 50 kHz, 20 kHz, 10 kHz, 5 kHz, 2 kHz, or 1 kHz 

102.4k-1.28k for 102.4 kHz, 51.2 kHz, 25.6 kHz, 12.8 kHz, 5.12 kHz, 2.56 kHz, or 1.28 kHz 

65.536k-1.024k for 65.536 kHz, 32.768 kHz, 16.384 kHz, 8.192 kHz, 4.096 kHz, 2.048 kHz, or 1.024 kHz. 

AR-LXDC2 

You can select 1k-1/60 for 1 kHz, 500 Hz, 200 Hz, 100 Hz, 50 Hz, 20 Hz, 10 Hz, 5 Hz, 2 Hz, 1 Hz, 1/2 Hz, 1/5 Hz, 1/10 Hz, 

1/30 Hz, or 1/60 Hz when the low-speed sampling DC amp card is installed.  

Select the sampling frequency. 

Lock the panel. 

Stop the fan during recording. 

Record voice memos. 

Set the clock. 

Settings for the monitor 
output and the generator 
output. 

Number of channels used for 
recording at the slot 1. 

Enable the slot. 

Move among the tabs.
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Memo 
Set to ON when recording or reproducing a voice memo. Voice memo data is recorded as a WAV file separately 

from the data and header files, using 8,000 bytes per second.  Note that this data increases even when the 

microphone is removed from the jack. 

 

 Voice memo is not recorded during the pre-trigger period. In playback, the voice is played back from the 

beginning of data. So, the voice and data are not synchronized.  

 

 

 

 

 

 When recording the voice memo under the (only) PC direct recording, click        or press the PAUSE 

button of the main unit to pause before recording stop.  

Fan 
When you set this to OFF, you can stop the cooling fan on the LX-10 for a period of 10 minutes from the start 

of recording. This is useful for recording noise. If you have already stopped the fan and recorded data, wait for 

about 10 minutes before you again stop the fan and record. 

When you set this to ON, the cooling fan is turned to on.  However, by clicking the fan stop button on the 

toolbar, you can stop the fan while recording.  Click again to restart the fan.  An accumulated time to stop the 

fan within a single recording (from recording start to stop) is 10 minutes.  The remaining time to stop the fan is 

displayed at the status display.  (See 3-3 Outline of Main Window, Toolbar and Status Display.) 

 

Panel 
When you set this to Lock, you can disable the control buttons on the front of the main unit.  

 

Clock 
Use this to adjust the internal clock on the main unit.  The current date and time according to the internal 

clock are displayed here.  

To change the date, click the ▼ button on the right of the date.  A calendar will appear.  In the calendar, click 

the desired date.  To change the time, click the digits you want to change and then either type the desired time 

or click the ▲ or ▼ button on the right of the time to increment or decrement the time value.  After you have 

changed the date or time values, click Set to apply the new settings. 

Click PC to set the date and time of the PC connected.  

 

Slot Use 
Turn on a check box to enable the corresponding slot to be used for recording or reproduction.  For Slot 1, you 

can choose the number of channels to be used for recording from 2, 4, and 8. 

Use the slot tab of the System dialog for the settings of the input and output amps enabled here. 

At the LX-20/20L, turn on Tacho check box to enable the tachometer pulse input channels.  

 

 You cannot use the tachometer pulse input channels and the generator output function at the time. 

 

 

Data reproduction

Voice playback 

Pre-trigger
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Monitor/Generator 
In Signal, select the monitor channel or the type of the generator output signals (only for the LX-20/20L) to 

be output from the MON OUT connector on the rear panel.  If you don't want to monitor any channel, set 

NONE.  

In Range set the output range. You can set the output range in 0.1 V steps, from 1 V to 5 V. 

Click Property to set the output range of the monitor channel or the details of the generator output signal.  

 

 

 

 

 

 

 

 

 

 

 

 

 

In Signal, select the monitor channel or the type of the generator output signals (sine, sweep sine, pulse, 

pink noise, or white noise from the MON OUT connector of the LX-20/20Ls).  

When you select the generator output signal, you can select the following parameters show at the dialog.  

(The parameters can be set are automatically appeared depending on the selection of the output signal.) 

 

Sin/Sweep 
Start Freq: Set the start frequency (Hz) when <sine> or <sweep sine> is selected at Signal. 
Stop Freq: Set the stop sweep frequency (Hz) when <sweep sine> is selected at Signal. 
Rate: Set the sweep rate when <sweep sine> is selected at Signal. 

Pulse 
Pulse Width: Set the pulse width when <pulse> is selected at Signal. 
Pulse Interval: Set the pulse interval when <pulse> is selected at Signal. 
 

Select the output range at Range from 1 V to 5 V at 0.1 V steps.  

 

See Section 6 for the specifications of the generator output.  

 

 You cannot use the tachometer pulse input channels and the generator output function at the time. 

 

 You cannot use the monitor output of the analog signal when recording at the low-speed sampling (1 

kHz to 1/60 Hz).  
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Input Amp Settings 
In the System dialog, click the tab of the slot in which the input amp is installed.  The setting parameters are 

valid depending on the type of the amps installed.  

 

DC Amp AR-LXDC/DC2 
<DC-8> is shown at the Slot tab. 

The AR-LXDC2 is a DC input amp equipped the low-speed samplings (1 kHz to 1/60 Hz) addition to the functions 

that the AR-LXDC supports. 

See Section 6 for the specifications. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Range Settings 

You can select from +/- 0.5, 1, 2, 5, 10, 20, or 50 V.  A range of +/- 131% of the selected range can be 

obtained for A/D (analog to digital) conversion value; however, the input margin level is approximately +/- 

120%.  Input the signal, then click  button on the right and specify the setting while checking the level.  

 

Auto 
When you input the signal and click Auto, the optimum input range is set automatically.  

 

Same Setting 
Check to apply the same settings to the channels later than the channel changed. 
 

 You cannot use the analog output signal of the monitor output and/or the analog output amp when 

recording at the low-speed sampling (1 kHz to 1/60 Hz).  

 

 You can reproduce the data recorded at the low-speed sampling from the analog output amp by changing 

the reproduce sampling speed at 1.5 kHz or higher.  

 

 

Select the input range. 

Check the input level.

Check the input levels of all channels.
Stop checking the input levels.

For the auto range setting.
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PA Amp AR-LXPA1/PA3 
Two types of the PA amps for a voltage output accelerometer input are available for the LX series.  

<PA-8> is shown at the Slot tab for the AR-LXPA1. 

<PA3-8> is shown at the Slot tab for the AR-LXPA3. 

The AR-LXPA3 is an amp equipped +/- 50 V input range and A and C weighting filters addition to the 

functions that the AR-LXDC supports. 

See Section 6 for the specifications. 

 

Cautions on Using PA Amp 
 

 Calibration 

It is suggested to use 0.01 V range of the LX PA amp after turning on the power for 10 minutes or more, and 

then executing manual calibration.   

In order to execute the manual calibration for precisely measurement, click       button on the toolbar 

of the LX Navi.  Also it is recommended to use the balanced input mode for precisely measurement. 

 

 Input Connection and Grounding 

When using many sensors or circuit signals of operations powered by a battery: 

Input Mode: Balanced (Bal) mode 

 

Whenever possible, connect the LX frame ground (FG) to ground. 

 

 

 

 

 

 

 

 

 

 

 

When using circuit signals (AC, ICP, DC) of operations powered by an AC power source: 

Input Mode: Balanced (Bal) mode 

Always connect the frame ground (FG) of the input signal source and the LX frame ground (FG) to ground.  

 

 

 

 

 

 

 

 

 

 

 

GND 

FG 

Vs 

- 

+ +

- 

LX Main Unit 

AR-LXPA

GND 

FG 

Vs 

- 

+ +

- 

LX Main Unit

AR-LXPA

GND 
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When using circuit signals (DC) of operations powered by an AC power source: 

Input Mode: Unbalanced (Unbal) mode 

If the frame ground (FG) of the input signal source is connected to ground, do not connect the LX frame ground 

(FG) to ground. 

 

 

 

 

 

 

 

 

 

 

 

When using circuit signals (DC) of operations powered by an AC power source: 

Input Mode: Unbalanced (Unbal) mode 

If there is no frame ground (FG) of the input signal source, connect the LX-10 frame ground (FG) to ground. 

 

 

 

 

 

 

 

 

 

 

 

 

GND 

FG 

Vs 

- 

+ +

- 

LX Main Unit

AR-LXPA

AR-LXPA

GND 

FG 

Vs 

- 

+ +

- 

LX Main Unit
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AR-LXPA1 Setting Dialog 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

AR-LXPA2 Setting Dialog 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Only combination of DC/OFF/FLAT selections is applicable at Bal/Unbal: Unbal.  
 

 At the AR-LXPA2 amp, you can select between 28 V DC and 24 V DC on the sensor power supply at the 

internal dip switch.  The factory default is 28 V DC.  Contact TEAC for 24 V DC setting.  

Select the weighting filter. 
A: A filter 
C: C filter 
FLAT: Flat 

Select HPF (High Pass Filter). 
OFF: No 
10Hz: 10 Hz 
20Hz: 20 Hz 

Select the input range (0.01 V, 0.0316 V, 0.1 V, 0.316 V, 
1 V, 3.16 V, 10 V) 

Select the coupling mode. 
AC: AC coupling 
DC: DC coupling 

Select turning ON or OFF of the power supply to 
the sensor connected. 
OFF: No supply 
4mA: Supply 4 mA constant current 

Select Balanced or Unbalanced input. 
Bal: Balanced 
Unbal: Unbalanced 
Automatically set to DC coupling for all 8 
channels when the balanced input is 
selected. 
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ST Amp AR-LXST1 
<ST1-8> is shown at the Slot tab for the AR-LXST1. 

The AR-LXST1 is an input amp applied for strain gauges and strain gauge type sensors and DC inputs. 

See Section 6 for the specifications. 

 

Cautions on Using ST Amp 
 

 Calibration 

It is suggested to use the LX ST amp after turning on the power for 5 minutes or more, and then executing 

manual calibration.   

In order to execute the manual calibration for precisely measurement, click       button on the toolbar of 

the LX Navi.  Also it is recommended to use the balanced input mode for precisely measurement. 

 

 Input Connection and Grounding 

When using sensors: 

Input Mode: Balanced (Bal) mode 

 

Whenever possible, connect the LX frame ground (FG) to ground. 

 

 

 

 

 

 

 

 

 

 

 

When using circuit signals (DC) of operations powered by an AC power source: 

Input Mode: Balanced (Bal) mode 

Always connect the frame ground (FG) of the input signal source and the LX frame ground (FG) to ground.  

 

 

 

 

 

 

 

 

 

 

 

 

GND 

FG 

Vs 

- 

+ +

- 

LX Main Unit 

AR-LXST

GND 

FG 

Vs 

- 

+ +

- 

LX Main Unit

AR-LXST

GND 
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AR-LXST1 Setting Dialog 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the input range. 
Click uST to turn the button at the right bottom to mV/V. 

Change the input range display 
between uST and mV/V. 

Change the bridge voltage. 
Turn to OFF to set the DC input range. 

Set the low pass filter. 
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Sensitivity Setting Using TEDS Functions 
When a transducer/sensor conforms to the IEEE Std 1451 A SMART TRANSDUCER INTERFACE is connected to 

the AR-LXPA1/AR-LXPA2, the LX can read its Transducer Electronic Data Sheet (TEDS) information, then can 

display the information and set the acquired sensitivity coefficient automatically to the channel that the 

transducer is connected.  

 

 If the information of the transducer is not complied with the IEEE TEDS standard template, the LX cannot 

read and display the information correctly.  

 

1. Click the toolbar icon         in the main window. 

 

 

 

 

 

 

 

 

 

 

 

2. The TEDS dialog is displayed.  If you turn ON the power of the LX after connecting the TEDS transducers, 

the TEDS information is automatically loaded at the initial calibration stage, and the LX displays the following 

window shown at the following step. 

 

 

 

 

 

 

 

 

 

3. Click Update to read the TEDS transducer information.  If you turn ON the power of the LX after connecting 

the TEDS transducers, the TEDS information is automatically loaded at the initial calibration stage, and the LX 

displays this window. 
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4. Click OK when <Update TEDS information> message is displayed. 

You can view the list of the TEDS transducer information connected to the amp, such as; 

Sensitivity (sensitivity), Unit (unit), Serial number (serial), Manufacturer name (manufacturer), and 

Calibration date (cal date).  

 

 

 

 

 

 

 

 

 

Turn on the check box of the channel to reflect the sensitivity of the loaded TEDS information.  

 

 

 

 

 

 

 

 

 

 

5. Click OK to write the applicable slope value (reciprocals of the loaded sensitivity) to the header file, then 

the window is closed.  Open the channel property list at the main window to confirm the slope value is 

updated based on the loaded TEDS information.  

(See 5-16 Channel Property.) 

 

 

 

 

 

 

 

 

 

Check box 
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Auto Offset 
The auto offset function of the LX Navi measures the voltage of each channel when clicking the Auto Offset 
icon, then reflects its voltage value to the header file.  The waveform data in the LX Navi displays Y-axis data 

by adjusting to zero by using this offset value. 

 

1. Click         on the toolbar at the stop state of the LX main unit. 

 

2. The Channel Unit table is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Click Auto Offset on the Channel Unit table at the timing to execute the offset.  The LX measures the 

voltages of the channels at the click timing and displays these values on the offset field.  

 

4. Click OK to apply the offset voltages displayed on the channels turning on their check boxes. 

The Confirm dialog is displayed and then click Yes to set the values.  
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Calibration By Using Calibrator 
You can use a calibrator or a pistonphone to apply a sensor sensitivity based on the actual measurement at 

the PA amp.  

 

 

1.  Click        on the toolbar at the stop state of the LX main unit. 

 

2. The Channel Unit table is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Click Calibration. 

 

4. The Cal. Sound/Vibration dialog is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. After the calibration is done, click Exit or click       to return to the main window. 

 

 

 

 

Select the channel. 

Select the type of the sensor to 
use. 

Select to use RMS or Peak value for 
calibration. 

Set the output level to match to the 
calibrator to be used. 

Start calibration. 

Being displayed the progress of the calibration. 

Apply the calibration result to the slope value. 
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Zero Balance 
Whenever turning on the power, use the zero balance function at the ST amp. 

 

 

1. Click         on the toolbar at the stop state of the LX main unit. 

 

2. The Strain Zero Balance dialog is displayed to start the zero balance. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Start Zero Balance ... is displayed while implementing the zero balance of all ST amp channels at the time.  

 

 

 

 

 

 

 

4. Completed is displayed when the zero balance has been completed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. After the zero balance is completed, click Exit or click      to return to the main window. 
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ＲＸ

ＬＡＮ

SERIAL NO.

MADE IN JAPAN

Setting Tachometer Pulse Inputs 
The LX-20/20L equips two of the tachometer pulse input channels in separate of analog input channels.  

Their input connectors are located on the rear panel.   

Either 16 bits or 32 bits mode can be selected.  When you select the 16 bits mode for one channel, another 

channel is automatically effective at 16 bits mode.  In 32 bits mode, you may select only one channel.  

See Section 6 for the specifications.  

 

 1 x 16 bits tachometer pulse input channel is equivalent to 1 x analog input channel.  1 x 32 bits 

tachometer pulse input channel is equivalent to 2 x analog input channels.  Therefore, if you turn ON 

tachometer pulse input channel(s), in order keep the same analog input channels, lower the sampling 

frequency is required by following the setting of tachometer pulse input channel(s).  

 

 Set Moving Average to [1] only, when the sampling frequency of 102.4 kHz, 100 kHz, 96 kHz, 65.536 

kHz, 51.2 kHz, 50 kHz, 48 kHz, or 32.768 kHz is selected.  

 

 Only 1 x 32 bits tachometer pulse input can be selected when the sampling frequency of 102.4 kHz, 

100 kHz, 96 kHz, or 65.536 kHz is selected.  

 

 The LX Navi cannot monitor the tachometer pulse input in wave form display.  Use the distal display to 

monitor. 

 The LX cannot playback the recorded tachometer pulse input signals.  Process the data as digital data 

file. 

 

 You cannot use the tachometer pulse inputs and the generator output function at the time. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For the tachometer pulse inputs
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At the System dialog, click the Tacho tab to set the tachometer pulse input channel parameters. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Turn on the check box for the tachometer pulse input channel to be used and select 16bit or 32bit.  If you turn 

on both channels, the number of the bits to be set must be the same.  Other parameters are show below.  

 

Parameters (Note to refer the articles mentioned at the previous page.) 

Parameters Details 

Measurement  Measurement mode 

pulse (gate) Pulse count mode within the gate time 

pulse (total) Total counts from measurement start to stop 

Period Cycle count mode 

Frequency Frequency measurement mode 

Rpm RPM measurement mode 

Range  Measurement range 

at pulse (gate) mode 1 to 255 times of the sampling frequency 

at period mode 1m, 5m, 10m, 50m, 100m, 500m, 1 sec 

at frequency mode 10, 20, 50, 100, 200, 500, 1k, 2k, 5k, 10k, 20 kHz 

at rpm mode 1500, 3000, 6000, 9000, 12000, 15000, 18000,24000 rpm

Threshold Level Threshold level setting +0.5, +1, +2.5, +5, +10, +20 V 

Divide Rate Divide rate 1 to 255 

Moving Average Moving average setting 1 to 16 

Pulse per Rev. Pulse per revolution 1 to 255 
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Output Amp Settings 
In the System dialog, click the tab of the slot in which the output amp is installed to set the output ranges.  

<AO-8> is shown at the Slot tab. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Output Range Setting 

You can select the output range from 1 V to 5 V at 0.1 V steps. 

 

 In the recording at the low-speed sampling mode (1 kHz to 1/60 Hz), you cannot use the analog output 

at the output amp.  

 

 You can playback the data recorded at the low-speed sampling mode (1 kHz to 1/60 Hz) by changing 

the playback sampling frequency at 1.5 kHz or higher. 

 

 Make sure to specify the source slot installed the input amp at the Output Slot. 
 

 At the LX series, the AD value of +/- 25000 is correspondent to +/- 100 % of the input range.  So that 

the output amp outputs the signal at the scale of +/- 100% as the specified output range.  For 

example, if you record + 1V signal at the 1 V input range and you set the output range at 2 V, you will 

obtain +2 V signal correspondent to the recorded 1 V signal. 

 

Select the output ranges.

Specify a source slot of the 
input amp for output. 



Outline of Trigger Recording 

4-19 

Outline of Trigger Recording 
In addition to manual operation, you can also start or stop recording automatically in the following modes. 

 

Repeat Mode 
Repeats the recording operation for a specified number of times, as shown in the following diagram.  

Recording once is also possible. 

 

 

 

 

 

 

 

 

 

 

 

 

 

<Recording-Start Conditions> 

 Level trigger 

The trigger is a change in level in a specified channel. 

 External trigger 

The trigger is a contact signal to the EXT TRIGGER IN connector on the rear of the LX. (L level: starts if 0.6 V or 

less)  If the level is already L when the system enters the recording-standby status, recording starts at once in 

memory/MO recording.  In PC recording, however, recording starts when the signal changes from H to L after 

the system enters the recording-standby status. 

 Time-out 

Recording is forced to start when the specified recording- start condition is not satisfied during a set period. 

 Pre-trigger 

A pre-trigger also records the data that was read into a buffer before one of the above recording-start conditions 

was satisfied.  The voice memo is not recorded during the pre-trigger period. 

 

<Recording-Stop Conditions> 

 Level trigger 

The trigger is a change in level in a specified channel. 

 External trigger 

The trigger is a contact signal to the EXT TRIGGER IN connector on the rear of the LX. (H level: stops if open or 

2 V or more) 

 Recording time 

Records for a specified period only. 

 Post-trigger 

Continues to record for a set period even after a recording-stop condition is satisfied. 

 

 

 To cause a trigger action, click        

in the toolbar or press the REC button 

on the main unit to put the system in 

the recording-standby status. 

 Even if a trigger action is enabled, the 

buttons on the toolbar and main unit 

are not disabled. 

Start Stop 
Pre-trigger Post-trigger

Recording start 
condition is satisfied: 
Level trigger 
External trigger 
Time out 

Recording strop 
condition is satisfied: 
Level trigger 
External trigger 
Recording time 
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Interval Mode 
Repeats the starting and stopping of recording for a specified number of times, during a specified period.   

Recording once is also possible.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(Example: When repeating 3 times) 

Stop
Specified recording time 

Specified time 

Specified pause time

Start Start StopStop Start 
Specified pause time Specified recording time Specified recording time
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Repeat Mode Settings 
To specify trigger action settings, from the Setup menu choose Trigger. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The settings in the above dialog box use a level trigger to start recording and an external trigger to stop 

recording.  A 10-second pre-trigger is specified, and recording is done once.  

 

Pre/Post 
Select this to enable a pre-trigger or post-trigger.  When Pre/Post is selected but the lower Repeat is not selected, the 

pre-trigger is enabled for starting recording by operations that use the toolbar or the buttons on the LX main unit. (The 

post-trigger is not enabled for stopping recording by operations that use the toolbar or the buttons on the LX main unit.)  

 

Start PreTrig/Stop PostTrig 
Specify the length of the pre-trigger or post-trigger in seconds or in scan units.  To switch the units, click a button on the 

right.  When 0 is entered, the pre- or post-trigger is disabled.  Specify a value that does not exceed the time possible 

using available free memory.  

 

 

 

 

Switch between seconds and scans.

Enable pre- and post-triggers. 

Specify the length of the pre-trigger. 

Use a level trigger to start recording. 

Enable the repeat mode.

Use an external trigger to 
stop recording. 

Number of repetitions. 

Set the level trigger (next 
page). 

Set the recording time.
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Repeat 
Select this to enable the Repeat mode. 

 

Start Condition 
Specify a recording-start condition.   If multiple conditions are set, the first condition satisfied will start recording. 

Level: Select this to enable a level trigger.  You can set level trigger details in the dialog box displayed by choosing 

Level Trig and then Property. (See the next page.) 

External: Select this to enable an external trigger. 

Timeout: If a level trigger or external trigger has been enabled, you can force recording to start if a specified 

recording-start condition is not satisfied during a specified period.  Specify the period in seconds.  When 0 is entered, 

Timeout is disabled.  

 
Stop Condition 

Specify a recording-stop condition.  If multiple conditions are set, the first condition satisfied will stop recording. 

Level: Select this to enable a level trigger.  You can set level trigger details in the dialog box displayed by choosing 

Level Trig and then Property. (See the next page.) 

External: Select this to enable an external trigger.  

RecTime: Enables you to stop recording after a set period has elapsed from the start of recording.  You can set the 

period in the dialog box displayed by clicking the button.  After you have entered a period, the period is displayed in 

this area.  

 

 Make sure to turn the trigger signal level to High before the next start, when you are using an external 

trigger for start with a repeat recording by using REC TIME.  

 

Repeat Count 
Specify the number of times the trigger recording operation specified above is to be repeated.  A file is made for each 

of the specified number of times. You can also specify 1 time only.  Specifying 0 will result in an unlimited number of 

repetitions (repetitions until you manually stop recording).  
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Level Trigger Settings 
To specify the details of the level trigger, click Level Trig – Property. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The settings in the above dialog box are such that recording starts when the input signal of channel 2 crosses 

from lower than +50% of the specified input range to higher than +50%, AND, the channel 3 signal crosses 

from lower than +50% to higher.  Recording stops when the input signal of channel 2 crosses from higher than 

-20% of the specified input range to lower than -20%. 

 

Channel selection 
In the list of channels, click the desired channel.  Alternatively, select the channel from the drop-down list box in the lower 

left of the window.  

Select the cross direction: 
Up: The condition is regarded as having been satisfied when the input signal crosses from lower than the specified level to 

higher.  The condition is regarded as not having been satisfied if the specified level was already higher when the 

recording-standby status was entered. 

Down: The condition is regarded as having been satisfied when the input signal crosses from higher than the specified 

level to lower.  The condition is regarded as not having been satisfied if the specified level was already lower when the 

recording-standby status was entered.  

Ignore: The channel is not monitored for the level trigger. 

Level settings 
The full scale of the specified input range is set to 100% on both the plus and minus sides.  You set the monitoring level 

for these in the range from -99% to +99%.  Enter a minus sign (-) for minus values. In the above dialog box, when the 

input range is 10 V, 50% becomes 5 V and -20% becomes -2 V.  

Logic 
When multiple channels are monitored for Start and Stop, specify whether these are combined using a logical AND or 

logical OR.  

Number of times condition is satisfied 
Specifies how many times a condition is regarded as having been established when a condition specified above (including 

the logical operator) is satisfied multiple times. 

Switch the logical operator. Number of items condition is satisfied. 

Click the channel you 
want to set. 

You can also select a channel here. 

Select the cross direction. 

Level settings. 
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Interval Mode Settings 
You can set trigger-action details in the dialog box displayed by choosing the Setup menu and then Trigger.  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The settings in the above dialog box specify that there are to be 4 recordings, each of which shall begin 

every hour on the hour from noon on August 15, 2001 and end in 5 minutes. 

 

Interval 
Select this to enable the Interval mode. 

 

Start Time 
Specify the date and time when the interval action is to start. 

 

Rec Time 
Clicking this displays a dialog box in which you can specify the recording period. The value you set is 

displayed in this area.  

 

Interval Time 
Specify the interval to wait before recordings. (Note that this is not the cycle period.)  Clicking this displays 

a dialog box in which you can specify the interval.  When recording to the media, the interval must be three 

seconds or longer; to memory or a PC, one second or longer.  The value you set is displayed in this area.  

 

Repeat Count 
Specify the number of times recording is to be repeated.  A file is made for each of the specified number of 

times. You can also specify 1 time only.  Specifying 0 will result in an unlimited number of repetitions 

(repetitions until you manually stop recording).  

 

Enable the interval mode. 
Specify the date and time of 
starting the interval action. 

Recording period

Pause period

Number of repetitions.
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Saving and Loading Settings 
The parameters that you set after choosing the Setup menu and then System and Trigger can be saved to a 

file and then loaded whenever required.  When you choose Params Property from the Setup menu, the 

following dialog box is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Saving Settings 
You save the set parameters as a file that has a .prm extension.  We recommend that you save your settings to 

avoid potential problems.  

 

1. Click Save at the Params Property dialog. 

 

2. When you select the LX (the media loaded into the LX main unit) for the destination to save, the LX 
Parameter File List dialog will be displayed.  Enter the file name to save the setting parameters at the bottom 

of the dialog, or select the file name to be changed its parameters, and then click OK.  

 

 

 

 

 

 

 

 

2. When you select the PC for the destination to save, the Save As dialog will be displayed.  Enter the folder 

to save and the file name, and then click [Save(S)].  

 

 The setting parameter file is saved as ASCII format, so that you can open the file by using the word pad 

program of Windows.  Never replace the contents, otherwise you cannot load the file at the LX.  

 

 

Load the settings.

Save the settings.

System information

Settings for each 
channel 

Select the load and save 
destination of a setting 
parameter file.

Loaded file
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Loading Settings 
Load the prm file once saved. 

 

1. Click Load at the Params Property dialog. 

 

2. When you select the LX (the media loaded into the LX main unit) for the destination to load, the LX 
Parameter File List dialog will be displayed.  Select the file name to load its parameters, and then click 

OK. 

 

 

 

 

 

 

 

 

The loaded file name is displayed at Params Property dialog. 

 

2. When you select the PC for the destination to load, the Open dialog will be displayed.  Enter the folder 
to load and the file name, and then click [Open(O)].  
 

The loaded file name is displayed at Params Property dialog. 

 

3. Click OK at the Params Property dialog. 

The LX will be set at the contents of the loaded file. 

 

 

 

 

 

 


